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This presentation focuses on the WebSphere® Application Server Toolkit Version 6.1.
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The first section of this presentation provides a brief overview of the Application Server
Toolkit and its architecture. This presentation will also cover the Web Tools Platform, and
all of the development tools that come as a part of it, and the additional functionality that
IBM has added on top of the Eclipse base. In addition, this presentation will show how to
install and get started with the AST, and also how to uninstall it.

WASvV61_ASTOverview.ppt Page 2 of 27



b

IBM Software Group

Section

Overview

o

“WebSphere Application Server Toolkit © 2006 IBM Corporation

The first section of the presentation provides an overview of the WebSphere Application
Server Toolkit V6.1 and its architecture.
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Application Server Toolkit overview

= Application Server Toolkit V6.0
» Focused on application assembly and deployment
» Limited creation tools available

= Application Server Toolkit V6.1

» Eclipse based IDE to enable developers to create,
assemble, and deploy J2EE™ applications to the
WebSphere V6.1 runtime

» Expands the functional scope of WebSphere tools

» Emphasis on providing positive development experience
for application developers

In V6, the main focus of the Application Server Toolkit was on application assembly and
deployment. Now, in V6.1, that focus has shifted to application development. The AST
still provides great application assembly and deployment tools, but it now incorporates a
richer development environment that includes a variety of tools and new wizards to
facilitate J2EE application development. The goal of the Application Server Toolkit is to
help you create, test, and deploy applications with WebSphere Application Server V6.1.

All the tools are integrated into a workbench to simplify the development process. Wizards
for creating Java™, J2EE, EJB, and Portlet applications help you get started quickly by
creating projects with a basic set of files. Editors provide code assist and validation to
improve productivity. Integration with WebSphere Application Server enables you to
quickly test and deploy applications from the workbench.
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Platform architecture

= Built upon the following technologies
» Eclipse V3.1.2
» Web Tools Platform V1.0
» Test and Performance Tools Project
» Graphical Editor Framework
» Eclipse Modeling Framework (EMF)
» Java SDK 5.0

IBM® Rational® Application Developer
IBM Rational Web Developer

3 Application
Server
Toolkit (AST)
Eclipse and the Web Tools Platform

I's helpful to keep in perspective where things are in the IBM® tools stack. At the bottom
of the stack you'll find Eclipse, which is an open source platform for developing integrated
tools. All three of the IBM development environments above — the AST and the IBM
Rational® Web and Application Developer products — subsume Eclipse and are
extensions of that base functionality. The higher up the stack you go, the richer and more
fully featured the tools become. The Application Server Toolkit, which is provided with
WebSphere Application Server Version 6.1, at no additional cost, is the focus of this
presentation. As such, this material will also cover some of the features of Eclipse and the
Web Tools Platform on which the Application Server Toolkit is built.

The Web Tools Platform is a generic, extensible and standards-based platform and set of
tools for J2EE and Web-centric application development. This is a relatively new Eclipse
project to which IBM was a large contributor. The AST includes many other Eclipse
projects as well — the Test and Performance Tools Project, the Graphical Editor
Framework, and the Eclipse Modeling Framework. The AST itself is running in JDK 5.0
and also supports Java 5.0 development.
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What’s new?

* Inclusion of Eclipse Web Tools Platform V1.0.2
= Jython development tools

= Tools support for developing JSR 116 SIP servlet
applications

= Tools support for developing JSR 168 Portlets

= Improved server tools for publishing and testing
applications targeted for WebSphere Application
Server V6.1

WebSphere Application Server Toolkit

The Web Tools Platform is a new addition to this version of the Application Server Toolkit,
and the next section of the presentation will examine this topic in more detail.

The Jython development tools provide support for administrative functions, including
support for wsadmin scripting and a new Jython editor. These features are covered in
more detail in a separate presentation.

SIP and Portlet application development support are also both new features in this
release. The SIP development tools are also covered in more detail in a separate
presentation.

Finally, enhancements have been made to the server tools to make it easier to publish and
test applications for WebSphere Application Server V6.1.
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The following portion of the presentation covers the Web Tools Platform.
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Web Tools Platform (WTP) overview
* What is the WTP?

» Eclipse-based project
» Provides a tools platform for building Web and J2EE applications

= Motivation

» Simplify development, deployment, and test of J2EE and Web
applications

» Add J2EE and Web tools to the Eclipse platform
= Status

» Version 1.0 released in December 2005

» AST includes WTPV1.0.2

Oy
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The Web Tools Platform is an Eclipse-based project that provides a tools platform for
building Web and J2EE applications. This is a relatively new Eclipse project to which IBM
has been a major contributor. Version 1.0 was released in late December 2005. Many of
the new development tools and wizards contained in the AST are a result of the inclusion
of the Web Tools Platform.
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Source: http://www.eclipse.org/webtools/releases/0.7/whatsnew.html

(JST)

- Web Standard Tools

(WST)

IBM Software Group Eﬁ

Web Tools Platform overview (cont.)
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The Web Tools Platform is made up of two major sub-projects: The J2EE Standard Tools
(JST) and the Web Standard Tools (WST). The JST encompasses all of the functionality
related to the J2EE 1.4 specification, such as servlets, JSPs, EJBs, and Java Web
services. The WST contains all of the language neutral functionality for building web
applications. It also includes editors, validators and document generators for artifacts
developed in a wide range of standard languages, such as HTML or XHTML, SQL, and

XML.
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Web Tools Platform overview (cont.)

Tools Description

Server Tools * Management of J2EE server environment from within IDE

= Access to runtime environment for deploying and testing applications
= Extension points for vendors

Web Tools = Editors and wizards for building HTML, CSS, JavaScript, etc artifacts
* Embedded Web browser and TCP/IP monitor

XML Tools = Editors and wizards for building XML, DTD, and XSD artifacts a. )
L Shalee
Web Services = Web services wizard, WSDL editor, Web services explorer, and WS-| test tool
Tools
J2EE Tools = Editors and wizards for building and managing J2EE artifacts ( %
» JSPs, servlets, EJBs, and deployment descriptors
__Show Me
Data Tools = Supports connecting and interacting with various database vendors
= SQL scrapbook

"
. ?
g

WebSphere Application Server Toolkit © 2006 IBM Corporation

The tools provided by the WTP fall into several different categories. The server tools
provide management of J2EE servers from within the development environment. You can
set up server connections, work with servers, and deploy and test applications. Many of
these activities are based in the Servers View at the bottom of the AST workbench. The
web tools provide special editors and wizards for creating several web artifacts, including
HTML, style sheets, JavaScript and others. It also includes an embedded web browser
and a TCP/IP monitor. The XML tools offer wizards and editors for building and validating
XML artifacts, including Schemas, DTDs, and XML files. The Web services tools provide a
WSDL editor and Web services wizards that can easily transform your other J2EE artifacts
into Web services. The J2EE tools offer a series of wizards and editors for creating and
working with J2EE artifacts, such as EJBs and servlets, and also special editors for
deployment descriptors. The data tools support interaction with a variety of databases.
Additional back-end database support for generating EJB deployment code has been
added for several databases in Version 6.1, including Cloudscape V10.1 and DB2® for
iSeries® V5R4.
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The next section of the presentation covers additional features of the Application Server
Toolkit that fall outside of the scope of any Eclipse projects.
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Portlet development tools

= Allows developers to build (e V__;
portlets based upon JSR ..
168 T
T Sowz. |
= Tools support includes L 3 |
» Wizards to create s T
= Portlet Projects “MMWWW""‘“"“" -
- Portlets o
. . | M type: [Emoty Porse: r'-l o
» Editor to manage the portlet B B
deployment descriptor
(portiet.xml) LB e [[Ew ] oo |
' Ablhty to import portiet WAR The Portlet project creation wizard
file will create an empty Portlet for you

and add it to the project
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The portlet development tools in the Application Server Toolkit V6.1 are compliant with the
JSR 168 portlet specification. The tools support creating portlet projects and portlets, and
also include a graphical portlet deployment descriptor editor. The portlets that get
generated extend the GenericPortlet class and contain stubs for all of the required portlet
methods. You can also import portlet WAR files using the AST. Since a portlet application
project is a J2EE-compliant Web application, you can import resources from a WAR file to
your project the same way that you would with any other WAR file (by selecting the File >
Import menu option).
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Web services tools

= Tools that use the WebSphere Application Server
runtime to create web services from:

» Java Bean
» EJB
» WSDL file

= Supports both JMS and HTTP transports

* New Web Services security wizard
» Simplifies enabling security

= UDDI test registry integration

The Application Server Toolkit provides tools for development, assembly, and deployment
of Web services. This focuses on the following tasks: creating Web services from the top-
down and the bottom up, editing Web services, testing and validating Web services,
deploying Web services, and publishing Web services to a test UDDI registry. The WSDL
editor allows you to create or modify WSDL files graphically so that you can create Web
services from the top-down. Wizards are also available to create Web services based on
a Java Bean or an EJB or other resources. The Web Service Editor allows you to modify
the service and client deployment descriptor files, changing values for such things as
handlers, security, bindings and service references. A Web services security wizard allows
you to quickly and easily configure the most common security options. Test Web services
using the Web services Explorer or the Universal Test Client. Validate your Web service,
WSDL files, or even the SOAP traffic passing through the service using a variety of
validation tools. When you deploy a unit test UDDI registry, you can add categories for use
when publishing to or searching the registry. You can use a category value file to populate
the category with values. Users of the registry can import the categories and associate the
values.
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Server tools

= Ability to publish/test applications on WebSphere Application Server
V6.1 running on a local or remote system

* Improved support for table and data source creator for defining
connection to the data source

= Improved enhanced EAR capabilities
= Can launch the Profile Management Tool tool from within the workbench
= Improved console support

= Support for import/export of profiles from within the workspace

Show Me

In this release of the Application Server Toolkit, you can now publish to any running
instance of WebSphere Application Server V6.1, either local or remote. The tools also
offer improved support for defining a connection to a data source, including support for
additional back-end databases. The Application Server Toolkit has improved the
WebSphere Enhanced EAR capability, which is used for packaging and preparing
applications for publishing to a WebSphere Application Server V6.X. The WebSphere
Enhanced EAR is the deployment page of the Enterprise Application Deployment
Descriptor editor. It has been updated to allow you to add resource adapters, connection
factories, message queues, and topics to an enterprise application targeted for
WebSphere Application Server V6.X. You can launch the Profile Management Tool
directly from within the workbench, and also remove the registry and configuration files
associated with a profile from within the workbench.
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The next section of the presentation discusses the installation and uninstallation process
for the WebSphere Application Server Toolkit V6.1.
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Installation wizard

= Wizard installation
» Start the wizard using the
install file
- <AST_IMAGE>/install.exe
» Installation steps

B Read/Acceptlicense agreement
= Specify install location
Review installation summary

Ess i
WebSphere Application Server Toolkit

© 2006 IBM Corporation
A simple wizard guides you through the AST installation. While stepping through the
install, you will need to read and accept the license agreement and specify the install

location (On Windows®, the default is C:\Program Files\IBM\WebSphere\AST). After that
you can review the installation summary and start the install.

WASvV61_ASTOverview.ppt Page 16 of 27



IBM Software Group Eg
Command line installation

= Application Server Toolkit can be installed silently from the command line
= Locate the following options x:\IMAGE_DIR\install_options.txt
» Modify the installLocation if you do not want the default
» silentinstallLicenseAcceptance.value must be set to true to accept the license

= |ssue the following command
» install.exe -silent -options "x:\IMAGE_DIR\install_options.txt"

Preference Response File Option Value
Product installation installLocation C:\Program Files\[BM\WebSphere\AST
directory
Software license silentinstallLicenseAcceptance.value | false
agreement

T
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A command line silent installation option for the AST is also available. You will need to
modify the install_options.txt file to use with your silent install. If you wish, you may
change the install location. However, you must update the license agreement information
in order to be able to run the installtion. By default, the value for accepting the license
agreement is set to false. You will need to change this to true in order to proceed with a
silent install. Once you’ve changed the install options file, simply run the install command
as shown.

WASvV61_ASTOverview.ppt Page 17 of 27



Getting started...

= Open the Application Server Toolkit by selecting Start > Programs >

IBM WebSphere > Application Server Toolkit V6.1 > Application
Server Toolkit

= Choose a project workspace

0 Resource - 18 WebSphere Application Server Toolkit, V6. 1 &)
e £t tosie Seydh Dot S i b |

Use the arrow
to go to the
Usetghgn%%t:ﬁ workbench
what the AST
is all about

Use the compass
to learn more about
the new features in
V6.1

% ]
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Once you've installed the Application Server Toolkit, you can open it using menu options.
Alternatively, you can launch the AST from the AST installation directory. When you open
the AST, you will be prompted to choose a workspace. At that time, you have the option of
making your selection the default workspace so that you won’t be prompted for it in the
future. The first time that you open the AST, you will see the Welcome Screen. It has
helpful links for exploring documentation and information on new features in this release.

If, at any time, you would like to return to the Welcome Screen, you can do so by selecting
Help > Welcome in the AST menu.
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Application Server Toolkit workbench
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This screen shows an example of a populated AST workbench. The views in the
workbench are all keyed off of the perspective. This workbench is currently in the J2EE
Perspective. As such, the toolbar contains special J2EE icons for creating EJBSs, the
Project Explorer is showing an EJB project, the Outline view contains information about
the EJBs in the project, and the Server view shows a server on which you can deploy your

J2EE application.
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Application Server Toolkit uninstall

= Before uninstalling
» Exit the Application Server Toolkit

» To uninstall

» Run the following command
= <AST_HOME>\uninstall\uninstall.exe

— Use —silent option for a silent uninstall
= Remaining files/directories after uninstall
» Files in the plug-ins or features directory that were modified
» Product logs are left to preserve a history of any install problems
» Workspace directories are not deleted

l
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You can launch the Application Server Toolkit uninstallation wizard by running the uninstall
executable. You can also uninstall the AST in Windows using the traditional Add/Remove
Programs interface — this will also launch the uninstall wizard. A command line silent
uninstall option is also available. It is important to close the Application Server Toolkit
before you try to uninstall it. After the product has been uninstalled, several files will
remain: any plug-in or feature files that had been changed, product log files, and
workspace directories.
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The last portion of the presentation contains a summary and references.
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Summary

* WebSphere Application Server Toolkit V6.1 helps
developers create, test and deploy applications

» Provides Wizards for creating Java, J2EE, EJB, Jython,
SIP and portlet applications quickly

» Provides editors with code assist and validation to
improve productivity

» Integrates with WebSphere Application Server V6.1

= Built upon Eclipse 3.1.2
» Includes Web Tools Platform 1.0.2

WebSphere Application Server Toolkit

In this release, the Application Server Toolkit has transitioned from being an application
deployment focused set of tools to being an application development set of tools. The
Eclipse-based IDE enables developers to create, assemble, and deploy J2EE™
applications to the WebSphere V6.1 runtime. The inclusion of the Web Tools Platform
brings along with it many Web application development tools and wizards. Special tools
have also been integrated into the workbench to support new features of WebSphere
Application Server V6.1, including SIP and portlet development and Jython scripting.
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References
= Eclipse
» http://www.eclipse.org/

= Web Tools Platform
» http://www.eclipse.org/webtools/
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Installation hardware requirements

Hardware Requirement

il
il

Processor = Intel Pentium Il 800 MHz processor (minimum)
= Higher is recommended

Memory * 512 MB RAM (minimum)
* 1 GB is recommended

Disk Space = 900 MB disk space
» 100 MB TEMP disk space is needed during

installation
Display * 1024x768 (minimum)

o
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Supported operating systems

= Windows XP

= Windows 2000

= Windows Server 2003

= Red Hat Enterprise Linux® 3.0

= Red Hat Desktop Linux 3.0

= SUSE Linux Enterprise Server (SLES) 9

%
WebSphere Application Server Toolkit © 2006 IBM Corporation
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